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Care and Maintenance 
The following safety precautions should always be followed during the 
using of your phone: 
� Make sure that your phone has been shut down in airplanes, and the 

wireless function has been disabled before going aboard, since it might still 
be working for a while after the phone is turned off. 

� Keep away from heat sources and high-voltage environment, such as 
electric appliances or electric cooking equipment. Keep the phone in normal 
temperature. The phone could be damaged in an atmosphere with 
temperature higher than 55� or lower than -10�. 

� Take action on anti-fire. You must turn off your phone when accessing 
highly inflammable articles. Shut down your phone in gas stations or fuel 
warehouse, etc. 

� Do not use a hand-held phone while driving. 
� Only use the standard battery, battery charger and the accessories 

approved by the mobile phone vendor. We take no responsibility for any 
damage or any results caused by using of the battery, battery charger and 
accessories from a third party. 

� Do not try to unpack the crust of the phone or battery. Nor to disassemble 
the phone or battery. 

� Keep away from electrical appliances such as TV, radio or personal 
computer, cardiac pacemaker and hearing aid, etc. Keep your phone away 
from credit cards and the magnetic area.  

� Do not subject your phone to mechanical vibration or shock. Do not click 
the screen with sharp objects. Rough handling can shorten the life of your 
phone. 

� The coating of the phone may be damaged if covered with wrap or vinyl 
wrapper. 

� Use only soft cloth to clean your phone. Do not use the solvent such as 
benzene, thinner or alcohol. Keep your phone away from harsh chemicals, 
strong detergents and solvent. 

� Do not expose your phone in excessive smoke or dusts, nor in strong 
sunlight. 

� Keep your phone dry. Do not use it in the environment of high humidity, 
such as in a bathroom. The phone is not waterproof. Do not subject it to rain 
nor to get wet. 

� Use the accessories like the earphone carefully. Do not touch the antenna 
unnecessarily. Only use the original antenna. The use of any unapproved 
antenna may damage your phone.  

� To plug out the charger from the phone, hold the charger and then pull. Do 
not pull the wire of the charger. Do not touch the charger with wet hands. 

� Do not use your phone as the only communication facility for emergency 
e.g., medical treatment and rescue.  

� Please keep your phone out of the reach of small children to avoid danger. 
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When using the battery, please follow the safety precautions as follows. 
� Before using the battery, please read the user guide carefully and pay 

attention to the labels. 
� Please charge the battery indoors with cool and airy condition (temperature: 

0-25�, relative humidity: below 65％).  If the environment temperature of 
charging is higher than expected, it leads the battery to get hot, smoking, 
distorted, damaged, blowing up, or even worse…explosion.   

� There are specific protecting circuits and parts inside the battery. Do not 
disassemble it. 

� Do not squeeze and short-circuit the battery. Squeezing and short-circuit 
may damage the battery and the components. Short-circuit can occur when 
a metallic object (such as coin, clip or pen) makes the direct connection of 
the ‘+’ and ‘-‘ poles of the battery. Therefore, do not put the battery together 
with metallic objects. 

� Keep the battery and its metal contacts clean. 
� Never use a damaged or exhausted battery. 
� Replace the battery which no longer working well. The battery may be 

recharged and discharged hundreds of times before replacement. The 
battery is rechargeable but it wears out eventually. When the working time 
(talk-time and standby time) of the battery is observably shorter than normal, 
it is time to replace it with a new one. 

� Do not expose the battery and charger in direct sunlight, nor subject to 
excessive smoke and dust. Do not use it in highly humid environment, such 
as in a bathroom. The battery is not waterproof; so do not subject it to rain 
or to get wet.  

� Do not leave the battery in a place too hot or too cold. The environment with 

the temperature higher than 55� or lower than－10� deteriorates the 
battery performance. 

� Do not dispose the battery in fire! Try best to avoid explosion.  
� Do not dispose the battery in water! Water makes the electronic circuit 

short-circuited and makes the battery hot, smoking, distorted, damaged, 
and exploded.   

� Dispose batteries according to local regulations (e.g. recycling). Do not 
dispose batteries as household waste. Try best to avoid explosion and 
pollution. 

� Only chare the battery with dedicated charger. Do not charge continuously 
for over 12 hours. 

� Please keep the battery out of the reach of small children to avoid danger. 
� All above mentioned precautions are equally applicable to your phone, 

battery and accessories. If any malfunction occurs, please take your phone 
to the nearest qualified service facility, where you will get assists or 
arrangements for service if necessary. 

When using the charger, please follow the safety precautions as follows. 

� Please carefully read the instructions and surface indication of the charger 
before use.  

� Do not disassemble or modify the charger. Do not use the charger in case 
the power cable is broken; Otherwise there might be the risk of electric 
shock, fire, or damage of charger.  
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� Do not touch the charger with a wet hand. In case the charger is in contact 
with water or other liquid, please cut off the power supply immediately.  

� Avoid shortcircuit of the charger. Avoid mechanical vibration or shake of the 
charger. Avoid exposure of the charger in the direct sunshine. Do not use 
the charger in the humid environment such as the bathroom. This device is 
not waterproof and should stay away from rain or moisture.  

� Do not use the charger in adjacent to the electric appliances such as 
television and radio.  

� Hold the charger when unplugging. The pulling of power cable may result in 
damage of it. 

� Place your phone out of the reach of children to avoid any danger.
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1    Overview  

What is inside the package? 

As unpack the box, you will look up the following: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* The above will be different with the product model, please depend on the final packing list. 

Appearance 

Front                                 Back 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  Before using your mobile phone, you should insert the SIM card, and insert and charge the battery. 
Make sure to detach the charger before inserting or removing the SIM card. 

 
Sides 
 

Mobile phone       Battery         Adapter        Mini USB Cable 

Protective bag        Stylus     Microsoft ActiveSync CD-ROM    User Manual  

Power 

Call  Contacts Calendar  End 

Receiver 

Touch Screen 

Flash light 
Stylus 

Mic 

Self-portrait 
Mirror 

Camera lens 

Speaker LED lights 
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Number keypad: 
 
 
 
 
 
 
 
 
 
Install the Number Keypad 
The Number Keypad is provided in the gift box. A screwdriver for 
removing the Number Keypad is also provided. Please make sure that the 
mobile phone has been shut down and all accessories have been 
disconnected before you remove the Mini keypad. The detailed procedures 
are shown as follows: 
Warning: Please keep the screwdriver away from children. 
 

（1） Remove the Mini Keypad 
Release the battery cover and take out the battery. Use the screwdriver to 
screw off the screws fixed within the Mini Keypad. And then you can pull 
the Mini Keypad downwards to remove it. 

 

Scroll key 

Mini SD 
Card slot 

Recorder key 

E
arpho

ne 
Jack 

R
eset 

C
o

m
m

u
nicato

r 

S
lo

t 

Left selection key Right selection key 

Left/Right key 
Number keys 

②
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（2）  Install the Number Keypad 
Unfold the Number Keypad, pull it upwards slightly and press down as 
shown in the following pictures. After that, fix the two screws tight into the 
battery compartment. 

               
    
Remove the Number Keypad: 
Pull the Number Keypad downwards and remove it as the following picture 
shows: 
  
 
 
 
 
 

SIM Card 

Before using the mobile, please insert the SIM card. The SIM card has a 
PIN code, which is supplied by your operator. For the first time of usage, 
you may be asked to enter the PIN code.   

1. Please press Power key to turn off the screen.  

2. After removal of the battery, please insert SIM card into the slot. 
Please pay attention to the direction. 

 

 
Notes: Before you use a new SIM card, you may be asked to enter the PIN 
code.The PIN code is made of 4-8 numbers, which can be provided by the network 
operator. If you enter the wrong number for three times, the SIM card will be 
locked. Please contact the network operator, or then the SIM card will be 
invalidated for ever.  

① ② 
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Tips: If you have not inserted the SIM card, please turn off the phone to enter the 
Flight mode to save power. 

Battery 

Warning! Be sure to use only with specific charger and in well ventilation 
environment with surrounding temperarure not higher than 50°C. Keep the 
charger away from fire. Never short-circuit or squeeze the battery. 
Before removing the battery, please make sure that you have disconnected all outer 
cables, such as the adapter and USB cable. 

Inserting the battery: 

1. Press down the battery cover and slide it downwards to remove it.  
 
 
 
 
 
 

2. Place the battery in the battery compartment.  
 
 
 
 
 
 

3. Place the battery cover and slide upwards. 

Notes:  Please press and hold the Power key to power on.  

Removing the battery: 

1. Disconnect all outer connections ,then press Power to turn off the 
screen. 

2. Open the battery cover and remove the battery. 

Warning:   Make sure to turn off your mobile and disconnect all the outer cable before 
removing the battery.  

Charging the battery: 

① 

② 

① 

② 
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When the battery needs charging, a battery low message will appear on the 
screen. As you use a new battery, charge the battery for at least 8 hours. 
Please remove the battery for a long term of storage. 

1. Please connect the mobile and the adapter. 

2. Connect the charger to the phone as shown in the picture below. The 
indicator on the top of the mobile is in steady green light as charging.  

3. As the battery is full, the indicator will become invisible. Then you 
can pull out the plug and disconnect the charger. 

 
 
 
 
 
 
Battery life estimates: 
� Talk-time:      4-6 hrs*     
� Standby time:  120-200hrs*  

Mini USB Cable 

Mini USB Cable connects the phone with PC to sync the data. Please see 
the ActiveSync chapter for the detail. As the phone is connected with the 
PC, it will automatically be charged. 

Usage of Mini SD card 

Your phone has an extended slot which is compatible with Mini SD cards. 
You can use them to backup and store your data and files.  
Inserting the memory card 

1. Hold your phone tight in hand and insert the Mini SD card in the 
right direction as shown in the picture below. When the card is 
fastened in the phone, it is totally fixed in the phone with nothing left 
outside. 
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Taking out the memory card 

1. Hold your phone, press down the top of the memory card. It pops up 
automatically. 

2. Take the card out of the phone.  
Tips: During the reading or writing process of the Mini SD card, please do not take 
it out, otherwise it will cause malfunctions. 

First Time to Use 

1. Insert SIM card. Only with the SIM card, you can use the wireless 
data function and the telephony. 

2. Install the battery. Please refer to the above section for battery 
installation. 

3. Plug the charger into the communicate socket of the mobile phone, 
and plug the charger into the wall socket or the junction box of power 
supply.  

4. If the phone has not been turned on automatically, please press and 
hold “Power” key until the screen displays. 

5. Follow “Welcome” wizard to finish the settings. 

6. Click the touch panel to Today menu. 
Notes: As each individual has his/her preference, the factory default settings might 
not be the best for you. Please change the settings from Settings/System according 
to your preference. 

Today 

 
 
 

 

              
 

(6)  

(1) 
(4) 

(5) 

(7) 

(3)  
(2) 

(8)
  

① Go to an application.  

② GPRS or connection information.  

③ Network status and options 

④ Tap to change the volume or mute all 
sounds.  

⑤ Tap and hold to change time format.   

⑥ A glance period.  

⑦ Tap to Phone 

⑧ Tap to Contacts 
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Icon Explanation 

 Adjust the system volume and vibration. 

 In charging. 

 Battery low. 

 Battery very low. 

 Battery full. 

 
The ON/OFF status and signal strength of 
the mobile connection. 

 GPRS is available. 

 One or more instant messages received. 

 
One or more mobile e-mail/SMS messages 
received. 

Selecting the Screen Orientation 

The phone supports two screen orientations: portrait and landscape.  
You can go to “Settings /Screen” and select the screen orientation from the 
two options, either in portrait/landscape for right-handed users, or 
landscape for left-handed users. 
 

 
 

Switching on/off the Screen 

Switch on the screen: 
� Press the Power button;  
� Press the shortcuts for the applications, for instance, Contacts etc. 

Warning:  make sure the Hold key disabled.  

Switch off the screen: 
� Press the Power button to switch off the screen. 
� As the mobile screen is turned off, your mobile is idle. For an incoming 

call, you can press Call
 
key to accept or press End to reject. 

Switch on the backlight: 
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� Press and hold the Power button to switch on/off the backlight. 
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Notes: By selecting the options in the Settings/Power, you can select the 
time duration to automatically switch off the device when it is in Idle. This 
consideration helps to save power and extend the working/standby time of 
the battery. 

Turn on/off your phone 

Turning on your phone: 
� Tap  and choose the “Wireless Manager”. Tap the “All” icon to turn 

off the flight mode. 

 
� Or press and hold the END key  to turn on your phone. 

The upright on the screen shows  as your phone turn on. 
 
Turning off your phone: 
� Tap  and choose the “Wireless Manager”. Tap the “All” icon to turn 

on the flight mode. 

 
� Or press and hold the END key  to turn off your phone.  

The upright on the screen will show  as your phone turn off. 

Warning ：：：：In the restricted condition, you must follow the ways as declared to turn 
off your phone and press Power key to turn off the screen. 
Tips: Enable Hold button to avoid the phone turned on casually when you carrying it. 
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Entering PIN code 

You can use the wireless function of phone only after you have inserted 
your SIM card. Generally speaking, SIM card is preset with a PIN code, 
which is provided by your service provider. 

1. Click“     Phone”。 

2. In the Dial window, enter the PIN code. 

3. Click the ENTER button. 

 
If you enter the wrong PIN code for 3 times in succession, the SIM card 
will be locked. In this case, please contact your service provider. Do not try 
to unlock yourself, otherwise your SIM card will be locked eternally. 

Restarting the phone 

If your phone does not respond to your operations on the buttons or touch 
screen, you’d better restart your phone. Restart will initialize your phone 
functions and reallocate the memory. Your data will be preserved. However, 
some unsaved data in running applications might have been lost. 

1. Plug the stylus from its slot. 

2. Use the point of the stylus to press the Reset button.  

Application Management 

Two ways to run applications  
•  From the “Start” menu, click the application icon. 
•  From the “Start” menu, tap “Program” to show more applications.  
 

Reset 
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Applications in the phone:  
 Icon Program Name Notes 

1  ActiveSync  Sync the inform between the phone and PC 

2  Calendar Create the appointments and the meetings 

3  Contacts 
Manage the information of your friends and 
colleagues  

4  Task Manage the tasks 

5  Notes 
Create notes, including handwriting and
recordings.  

6  Pocket MSN 
Visit MSN Pocket Hotmail and MSN 
Messenger 

7  Messaging Receive and send Email/SMS/MMS  

8  Internet Explorer 
Browse the web page or download files from 
Internet  

9  Phone Make or answer calls 

10  SIM Toolkit Network service 

11 
 

Scene mode Quick set the scene mode 

12  Camera Take pictures /record videos. 

13  Excel Mobile Create or edit the excel file 

14  Word Mobile Create or edit the doc document 

15  Powerpoint Mobile  Show the ppt file 

16  Windows Media    Play the audio and video file  

17  Picture and Video Browse the pictures and video 

18 
 

Explorer Manage all files and programs 

19  Search Look up the information 

20  Solitaire Enjoy the Solitaire everywhere 

21  Bubblebreaker An interesting Bubblebreaker game 

 



 

 20 

Exit the Application: 

1. In Today window, click  ---Settings. 

2. In the System panel, click the Memory icon. 

3. Select to the application from Running Programs, and click “Stop” 
button to quit.  

 

Phone Protections 

Keyboard and LCD lock  

Please slide the HOLD  key to the Lock position, in order to avoid turning 
the phone on casually during carrying. When it is in the status of lock, your 
phone does not response to your operations on the LCD and keyboard. 
However, you can get call-ins. Press TALK  key to answer the coming calls 
or press END key to reject it.  

Phone password 

There is quite a lot of personal information stored in the phone, and some of 
them are very personal. In order to protect unauthorized access, you can set 
the password. When using the Number Keypad, please unfold the keypad to 
input the password. 

1. Tap  --Settings. 

2. In the Personal panel, click the icon of the Lock . 

3. Select the Password. 
� A simple 4-digital password. 
� Strong alphanumeric (including complicated digitals and letters). 

4. Select the time duration to be unused for the device when it is in Idle, 
i.e., to select from the options of “Prompt if device unused for”. 
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When the phone is not used for longer than the set time duration, 
correct password is needed to reactivate the phone. 

5. Click “Hint” to enter a password hint in case you forget your 
password. 

6. Tap “OK” to save your settings. 

Warning ：：：：You should remember your password. If you forget, you can get your 
password back via the password hint. In case you even forget the password hint, 
you have no other choice except contacting the local service.   

Security code 

You can use the following descriptions of PIN to protect your phone against 
unauthorized use. 
 
PIN code  
It protects the SIM card against unauthorized use. If your phone has already 
started the PIN code for protection function, after switch on, the screen will 
show a hint to input the PIN code. If you enter an incorrect PIN code three 
times in succession, the SIM card will be locked automatically. You must 
input the PUK for unlocking. The PIN code can be obtained from the 
network operator. 
 
PIN2 code 
While using the special functions as calculating charges and fixed dialing 
supplied by the network, the required personal identification code is 
generally provided together with the SIM card. These functions are 
available only under the SIM card support.  
 
Warning: If you enter an incorrect PIN code (PIN2 code) three times in succession, 
the SIM card will be locked. Please contact the network operator immediately for 
the decoding help. Trying to decode by yourself may cause the SIM card to be 
invalid permanently. 

Entering text 

There are four text input methods: 
 
Block Recognizer 
With Block Recognizer you can write on the screen with the stylus. Write 
letters in the left box (labeled abc) to create letters; Write numbers in the 
right box (labeled 123) to create numbers.  
 
Keyboard 
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Soft Keyboard is a keyboard showed at the bottom of the screen. You can 
click the letters accordingly for data input.  
 
Letter Recognizer 
With Letter Recognizer, you can write on the screen with the stylus. Write 
capital letters in the left box (labeled ABC) to create capital letters; Write 
small letters in the middle box (labeled abc) to create small letters; Write 
numbers in the right box (labeled 123) to create numbers.  
 
Transcriber 
With Transcriber, you can write on the screen with the stylus exactly in the 
same way as you write on a piece of paper. Different from Letter 
Recognizer and Block Recognizer, you can write a sentence or a series of 
letters and then turn them into print Enters.  
 
Switch among Different Input Methods 

1. Tap the “�”icon on the centre of the menu and select the input 
method you want. Click the icon again to close the input panel. 

 
When you input through the panel, the phone can automatically recognize 
the word you input, and shows the word matched on the panel. You can 
directly click it for input.  
 
Note: To change the word completion settings, click “Settings” and select 
“Personal/Input” icon, then click “Word Completion”  to modify the settings. 

Writing on the Screen 

In some programs, you can write directly on the screen. You can write a 
phrase or even a sentence before they are recognized and turned into print 
Enters.  
In case of recognize error of some words, you can select the error words 
and choose “Spell Check” in the menu for correction.  

Drawing on the Screen 

You can directly draw on the screen in some programs. 
There will be grids on the screen when drawing. If the first paint goes 
across three lines of grids, a paint frame will appear. The following paints 
or those in contact with the frame will be regarded as part of the drawing. 
(The paint that does not go across three lines of grids will be regarded as a 
text input.) 
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Recording 

Recording can be a very convenient way of data input. By recording, you 
can make records on notes, messages, telephone numbers, and etc. In Notes, 
you can make and save an individual recording file, in some programs such 
as Notes and Word; you can embed recording objects within the document.  

1. Please keep your mouth or sound source close to the microphone of 
the device.  

2. Press and hold the recording button, when you hear a beep, the 
recording starts. Keep holding the button to continue recording.  

3. Release the button after the recording is over, when you hear two 
beeps, the recording completes. The recording file is displayed as an 
icon of speaker in the file. 

Notes: You can start the recording or play by clicking the buttons in the Recording 
bar accordingly. 
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2   Phone* 

Dial Window 

1. Press Talk key  to show the dial window. 
 
       Number Window                     Function key Window 
 
 

                                

 
 

Indicator Meaning 

 
Phone off or out of network service. 
Click this icon to turn on Wireless 
Manager prompt. 

 
In network service. Click this icon to 
turn on Wireless Manager prompt. 

 Indicates that signal is at full strength. 

 Voice calls active/Call on hold. 

 
Call Missed. Click this icon to view 
the call(s) you missed. 

 
Unread E-mail or SMS. Click the icon 
to view unread SMS or E-mail. 

 GPRS is available. 
 
 
 
* In this chapter, marked** : the functions need the SIM card supports. 

marked*** : the functions need the network provider supports. 
 

Setup 

Show the signal strength of 
the cellular network 

Speed Dial Soft Keypad 

Display Area 

Call History 

Backspace 

Talk 

Speaker Volume and 
Vibration 

Contacts 

Switch to the 
Number window 
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Making a Call 

Making a call using the soft keypad：：：： 

1. Press Talk key  to enter the DIAL window. 

2. Enter the digits with the soft keypad and click Talk on the bottom 
right of the keypad, or press Talk key.  

 
 

Making a call using the Contacts：：：： 

1. Press Contacts key  . 

2. Press and hold the contact you want to call, and select the phone 
number.  

 

  
 

Making a call using the Call History：：：： 

1. Press Talk  key  to enter the DIAL window.  

2. Press Call History  button. 
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3. Call History provides the time and duration of all missed calls, 
outgoing calls, and incoming calls. Press the icon  in front of the 
information to make a call.  

 

 
Making a call using the Message：：：： 

1. Click the “Text Messages” in Today window.  

 

2. Select the message you want to call. 

3. Press Talk key  twice。 
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Making a call using the Speed Dial：：：： 

1. Press the Speed Dial button, and select the speed dial location 
number of the desired contact. 

2. If Speed Dial is set to on, press and hold a speed-dialing key until the 
call is started.  

3. You can assign a phone number to one of the Speed dialing key. See        
Speed Dial section. 

Ending a Call 

1. Press End key  or End button. 

Answering or rejecting a Call 

1. To answer an incoming call, press the Talk key, or to reject an 
incoming call, press the End key . 

Options during a Call 

Changing the volume 

1. Scroll the scroll key to change the volume. 

2. Press the volume icon in the up right corner of the window to change. 
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Mute 

1. Click the Menu and the Mute option in the down right corner of the 
phone window. 

Call History 

You can check the record of all calls, including the most recently incoming 
calls, missed calls, and outgoing calls. In Dial window, you can use the 
scroll key or Navigation to access to the call history.  

：Missed calls ：Incoming calls  ：Outgoing calls.  
 
Viewing the call history 

1. Select the call record you want, the time data will be displayed 
automatically below the record. 

 
Making a call 

1. Click the Icon (for instance ) before the calls record you can make 
a call directly. 

Sending a SMS 

1. Press and hold the call record, you can get a popup menu, and click 
“Send Text Message” to send a SMS. 
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Deleting the call history 

1. Click the Menu, which is in the bottom right corner of the window, 
to get the popup menus. And click “Delete all calls” option to delete 
all the call records in the call history.  

Tips: If you want to delete one record, please press and hold the record to choose 
“Delete” from the popup menu.  
 
Viewing the Call Timer 

1. Click the Menu at the bottom right corner of the window, and select 
the “Call Timers…” option. Then you see the time records for the 
calls.  

Speed Dial 

1. Press the Talk  key to enter the Dial window. 

2. In the Dial window, click Speed Dial button to open the speed dial 
window. 

3. In the window, click the “New” in the bottom right corner; select the 
contact from the “All Contacts” list.    

4. In the Speed Dial window, select the speed dial number from the 
Location box, and click “OK” to save it.  
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Emergency Calls  

Your mobile phone supports the international emergency calls. When and 
only when you are in the coverage of network, you can call the emergency 
number, such as 112, no matter the SIM card is inserted or not. 
Notes: There exists the possibility that your operator has the local emergency call 
number.  
Some mobile operator might require SIM card inserted before you dial the 
emergency call. Even more, there are possibilities that PIN code needed for the 
emergency call service.  

International long distance Calls 

To dial an international call, of which the phone number is not saved in 

your phone or SIM card, press 0 until “+” is displayed. “＋” replaces the 
“00” for the international calls. Then, enter the whole phone number, 
including the country code, area code (no more the first ‘0’) and the phone 
number. And click the TALK  button or press the Talk  key . 
 

  

Call Waiting ***  

Call waiting function makes the short alert for a third-party incoming call 
when you during a call. In the incoming call window, click Ignore to refuse 
the call, or click Hold to switch to the 3rd call. This function needs the 
support of the operator. 
 
Hold the call: in the incoming call notification window, click Answer 
button to hold the current call and switch to the new incoming call. 
Swap: you can click the  button to switch between the calls. 
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Conference Call*** 

Conference call allows you to talk with several ones together. This function 
needs the support of the operator. 
 

 

Text Messaging 

Sending a message 

1. In Today window, click “No Unread messages”. 

 
2. In the window, tap “�” to select “Text Messages”. In Messaging 

window, click the New in the bottom left corner. 

A new incoming 
call 

Online phone 
number 
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3. Enter the phone number in <To> bar. Use “;” to separate the phone 
numbers. 

4. Or, click the icon “To” in the toolbar to get the contacts list and select 
the contacts there.  

5. Enter the body text. You can also click “My Text” to enter preset 
phases. 

6. Click Send button to send the message. 
Tips: your phone has the function of Group message. You can enter many phone 
numbers in the To box, and the message can send to all the receivers together. Be

 sure to use semicolon to separate the numbers. 

Reading a message 

When a new message arrives, there is a dialog displayed with a sound alert 
to tell you of the coming new message. The default setting of new text 
message alert is Sound and Light. After the alert window disappears, there 
is an icon  remained on the top right corner of the screen. The message 
line in the Today window also has notifications. 
1. Click the text message icon  or the Message line in the Today 

window, you can read all messages in Inbox.  

 

Managing the messages 

1. In the Today window, click “No unread messages”. 

2. Click the folder list and you can view all the text messages in the 
folders of Deleted Items, Drafts, Inbox, Outbox and Sent Items. 

3. To delete the text message: you can use the stylus to select those 
messages you want to delete. And press on them until the popup 
menu pops. Select “Delete” to delete the messages. 

Text Messages settings  

1. In the Today window, click “No unread messages”. 



 

 33 

2. Click Menu and select the Tools > Options. 

3. Signature settings: in the Accounts panel, click “Signatures” button. 
Then enter your personal preferences, and click OK  to save. 

 
4. Message service center settings: before you can use the text message 

services, you must enter the number of the service center, which is 
provided by the network operator. Select Phone > Menu > Options > 
Services > Voice Mail and Text Messages, then click Get Settings to 
modify the service center number. 

MMS Messaging 

The usage of MMS is very similar to email. You can send pictures, audio 
file, text and multimedia message via MMS. How much MMS contents can 
be sent in a MMS depends on the operator system. For details, please 
contact your operator.  

Creating a new MMS 

1. In the Today window, click “No unread messages”. 

2. From the folder manager, choose the MMS. 

3. Click the “New” in the toolbar. Enter photo, text, and audio in their 
areas, following the hint. You can click “Edit” to add more slides. 

  
Insert Audio 

Canned text 

Insert picture 

Insert text 
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4. Click  to preview the MMS. 

5. Click Send to Send panel. Enter the phone numbers, which you want 
to send the MMS to, or the email address. And click “Send” button.  

Tips: pay attention to the size of the MMS before sending. If your MMS is larger 
than the up limit that the operator supports, you cannot succeed to send the MMS. 
The one who you send MMS to should have a phone, which also has MMS function 
to read your MMS. Suggest you use email system, that is, enter email address and 
send the MMS to the email box.  

Set the Scene mode 

1. In today window, click “Scene Mode”.  

 

2. In the window, choose the setting mode.  

 

3. To modify the scene: click “Edit” button and modify the option from 
the yellow arrow. After modifying, please click “OK”. 
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4. Click OK。 

Ring Setting 

1. In the Today window, click “RingSetting”. 

2. In Sounds setting window, you can set up the ring type, ring tone, etc. 
Click the ring file name from the list and you can play the ring. 

3. Click “OK” button to save and exit the setting. 

 

Ring-tone downloading 

You can have several methods to download the ring tone to your phone and 
enjoy your personalized ring tone: 

� Via Pocket Internet Explorer to get the ring tone files.  
� Via Bluetooth appliance to send the ring tone file. 
� Via PC-sync to copy the ring tones from your PC to your phone. 

Notes: the ringtone files support .wav ,.wma and .mp3. The ringtone files should be 
saved in the directory of “My Documents”.  

Phone Setting 

You can set functions relating to the phone. The service is subject to the 
network. 

1. From the Dial window, tap Menu-Options-Services.  

2. Choose your setting option and tap “Get setting”.  

3. In the service window, select the setting as you requested. 

Call Barring 

This function prevents your phone from making or receiving certain 
category of calls. 
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--All calls: Restrict all incoming / outgoing calls. 
--When Roaming: Restrict all incoming / outgoing calls except those 
from your registered network when roaming. 
--Off: Cancel all barring services. 

CALL ID 

This service can prevent the master number from being sent out when 
dialing a call. 

Call Forwarding 

You can also use call forwarding to forward incoming calls to a different 
number based on your situation. 
Unavailable: to forward calls only when your phone is turned off or you 
are unreachable. 
Busy: to forward calls only when the line is busy. 
No answer: to forward calls only when you can’t answer your phone. 

Call Waiting 

If a third party call tries to dial you while you are in a call, your network 
usually tells the third party that you are busy and automatically hangs it up. 
If Call Waiting is set to On, the network will ask the third party to wait 
on-line and notify you by the alert tone or show you the caller’s number 
that you have a waiting call. 

Network 

This function allows you to select a network automatically (Auto) or 
manually (Manual).  

1. From the Phone keypad, tap Tools-Options-Network tab.  

Voice Mail***  

Voice mail service is similar to the phone call recording. When you can not 
answer an incoming call, it can be recorded as a Voice Mail. A new SMS 
will be sent to your phone as a new voice message in your Voice Mail 
inbox. The service depends on your network operator. 
Notes: The Voice Inbox must be used with the Call-Forwarding and SMS.  

To set the Voice Mail: 
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1. Press Call to enter the DIAL window. 

2. Click “Menu-Option” on the left down corner.  

3. In the “Services” window, you choose “Voice Mail and Text 
Messages” and “Get settings”. 

 

 

4. Please input your voice number, and click OK to save. For detailed 
information, please contact your network operator. 

Listening to the voice message: 

1. Press “1” in the Dial window to dial the voice info number. Press and 
hold the number “1” key in the Dial window to dial the voice info 
number. 

 
2. The phone design the “1” number to the Voice Inbox.  

Contacts 

Contacts are like an address book, in which you can store names, phone 
numbers, email addresses and other useful information. You can 
synchronize the contents in contacts with your PC by ActiveSync. 
The information stored in the SIM card is accessible in Contacts. You can 
create new and edit contacts in the SIM card. 

View the Contacts 
1. Click “     Contacts ”to open the Contact lists。 

� Work――Work phone； 

� Home――Home phone；  

� MP――Mobile phone； 
� Email――Email address. 
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� ――Save in the SIM card 

  

To create a new contact 
1. Click “New” in Contacts window. 

  

2. Click the input panel, and then input the information of the contacts.  

3. Click the “Select a picture…” after the picture, to appoint the 
coming-call picture. 

4. Click the “Ring tone” to choose the ring tone file.  

5. To select a category for the contacts, click the “No Categories” next 
to the “Categories” and then tick on the category you prefer. Or, you 
can create a new category. 

6. Click “Notes”, then you can add supplementary information by text 
input.  

7. Click the “OK” button at the upper right corner to save the inputs. 

SIM Card Contacts  

To Create a new SIM Contact 

1. Press Contacts button.  

2. Tap Menu and “New SIM contact” on the down right corner.  
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3. Input “Name” and “Telephone number”, then click “OK” to save.  
 

To save the contacts into SIM card  

1. Click the contact, and then open the view window.  

2. Select the phone number, and then tap Menu and Save to SIM.  

 

3. Tap OK to save. 

Operate by the Number Keypad 

When the Number Keypad is installed, the phone will automatically 
initialize a mini screen, where you can view information of contacts, scene 
mode and call records, and dial or answer calls, take photos and enjoy your 
music. If you want to conduct more complicated operations, please unfold 
the Number Keypad. Only key operations are supported in the small 
function screen mode. The touch panel function is disabled. 
 
Stand-by Interface: 
 
When the phone is idle for a certain period of time, the mini screen will 
enter the Stand-by Interface, where information of time, scene mode, and 
battery status and signal strength are displayed. If you have set the auto-off 
time, the mini screen display will also be turned off at the preset time. 
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Main Interface: 

In the stand-by interface, the mini screen will enter the Main Interface by 
pressing any key of the Number Keypad. 

You can select the current application program by turning the roller or 
pressing the direction key. 

Press “OK” button to open the selected application. 

 
 
Dial: 
1. Input the telephone number you want to dial by pressing the number 

keys, and press “Delete” key to delete the wrong input. 
2. Press “ ” key to dial. 
 
Speed Dial: 
1. If you have established speed dial settings, you are able to make a 

speed dial by pressing the correspondent number key and then “ ” 
key. You can also make a speed dial by pressing and holding the 
correspondent number key. 

 
Answer a call: 
1. When there is an incoming call, press “ ” key to answer and 

“ ” key to reject. 
 
Contacts 
1. In the Contacts window, turn the roller or press “Left” or “Right” key 

to browse contacts, and press “View” to display more detailed 
information. Select the number you want to dial, and press “Call”. 

 
Intelligent Retrieval: The intelligent search function is supported when the 
Number key in being used. In the Contacts window, press the letter or the 
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number key, the phone will intelligently match them and all met records 
will be listed. 
 
Call Records 
1. In the Call Records window, you can view all call records. 
2. Select the call record and press “” to dial this number. 
 
Scene Mode 
1. In the Scene Mode window, turn the roller key or press the direction 

key to select the required mode, and press “” key to save the 
selected scene mode.  

 
Earphone mode: when earphone is connected to the phone, it will be 
automatically switched to this mode. This mode does not support manual 
selection. 
 
Camera 
In the small screen, you are able to capture photos and record videos. Press 
the camera key to capture. 
In the video recording interface, press the Camera key to start recording, 
and there will be a flickering red dot icon. Press the Camera key again to 
stop recording. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
Media Player 

Initialize Camera 
Start capturing or recording 

Switch between 
“Capture/Record” 

Exit Camera 
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When you have set your play lists in the Windows Media Player and the 
music is being played, you are able to control the play function buttons and 
volume by number keys. 
 

 
 

Tips: Before making a call, please press " " key or "Return" key to exit 
the Media Player interface. 
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3   Connecting to the Internet 

Connecting to the Internet 

Before you can use Internet and Messaging to access the Internet and send 
or receive messages, you must make some user-specific settings. 
 
� Pocket Internet Explorer 
� MMS 
� Email Inbox  
� MSN Messenger 

 GPRS 

Many network operators offer both GPRS and GSM services. For the 
details of the setting information, please refer to your operator. 
 
Manual settings for the GPRS service. 
1. Tap “  >settings>connections> connections”. 
2. Tap “Add a new modem connection”.  
3. Enter the connection name and select a modem type, press the 

“NEXT” button. 
4. Name the connection, such as “My GPRS”. And you can select 

“Cellular Line” or “Cellular Line (GPRS) from the list box “Select a 
modem:”. 

5. In the Access Point Name, input the name and click “Next”; 
6. Enter the “User name”,” Password” and “Domain”; if necessary, click 

“Advanced” to set up the other information. 
7. Tap “Finish” button. 
 
Disconnected GPRS connection 

1. Tap the connection icon  in the navigation bar and click 
“Disconnect” button. 
Or Press End key . 

Tips: When you are not using the GPRS, please disconnect it to save power. 
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Pocket Internet Explorer 

1. Press “  --- Internet Explorer”. 

2. Enter the URL of the web you want to visit in the address bar of the 
IE. Or select those listed to visit the link. 

 
 
 
 
 
 
 
 
 
 
 

3. Click the “Go to ” icon, the green icon at the right side of the address 
bar to enter the web site. 

Sending Email 

Inbox is to receive the emails from Internet. You can get the POP3 emails 
from the Internet. You can also use AcitveSync to synchronize the emails 
with Exchange or Outlook in PC.  

Email Service Setting 

1. Click  －Messaging and get the Inbox Window. 

2. Click the Menu- Tools in the bottom of the window. In the popup 
menu, select “New Account…” . 

 

3. Enter the E-mail address. 

Address bar Go to 

GPRS 
Connecting Icon 
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4. Click “Next” button to continue the settings. 

5. Select POP3 as the account Enter. 

6. Enter the server information. For the details, contact the email service 
provider for the settings.  

 

7. Click the Options button to setup the SMTP settings. 

 

8. Click “Finish” button to save. 

Receiving Email 

1. In the Inbox window, select “Menu – Send/Receive” option.  

2. When connected with the Email server, the emails in the Outbox will 
be sent automatically, and new emails will be received into the Inbox.  

By default, the Inbox only downloads the head of each email, instead of 
downloading the attachment in the emails. You can change the default 
settings of the email server. If you want to read the entire message, you 
mark the email first and connect with the mail server or re-synchronize. 
Click the”←” or “→” arrow to read the previous or next email.  

Writing Email 

1. Click “New”, which is in the bottom left of the window. 
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2. Enter the email address of the receiver in the To textbox, or click the 
Contacts button to select the email address of the receiver from the 
Contacts list. 

3. Enter the subject and the email content in the corresponding 
positions. 

 
Send attachments: click the Menu in the bottom left window and get the 
menu. Select “Insert” and open the File Explorer to add the attachment. 
Send the recorder file: you can select “Insert” and open the Voice Note, 
click the Recorder button on the toolbar to record. The phone adds the 
recorder file as the attachment automatically. 

4. When you finish writing the email, click the “Send” at the bottom left 
corner of the window to send the email. Or click the OK button to 
save the email in the Draft box.  

Tip: when your phone is connected with the email server, the email is send directly. 
If your phone is offline, the emails are saved in Outbox. Once you connect with the 
email server to synchronize with PC, the emails will be sent automatically.  

Pocket MSN 
Pocket MSN can visit MSN Hotmail and MSN Messenger. 

MSN® Messenger 

Requires: 

� Microsoft Passport™ Passport or Microsoft Exchange Email account。 
� MSN Messenger Passport. If you have a hotmail account or MSN 

account, you have a passport. 
Setting an account 
Before connecting, you must input your Passport or Exchange account. 

1. Clicke the Options from the Menu. 

2. Input your Passport or Exchange account。 

3. Click "login in" and type your Email and password to login. 
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Tips：：：： Your contacts will show in your phone autoly if you have used it in PC. 
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4   ActiveSync 
With Microsoft ActiveSync on both your PC and your Phone, you can 
exchange information between a PC or server and your Pocket PC Phone. 
The process is called “synchronization."  
To synchronize your Pocket PC Phone with your PC, you must install 
ActiveSync 4.1 or above version on the PC.  

Installing Microsoft® ActiveSync®  

1. Please close all applications, including those which are started 
automatically when the system is turned on. Close all the anti-virus 
applications/tools. 

2. Insert Microsoft ActiveSync CD. And you can see the welcome 
panel. 

3. Click the Next icon into next panel. 

4. Click “Start from here” option.  

5. Read the installation statement.  

6. Click the corresponding buttons to install the following applications.  
•  Outlook 2002 (suggested) 
•  ActiveSync® 4.1 or above 
After installation, the ActiveSync icon will be displayed on the system 
toolbar of your PC. For more details, please refer to ActiveSync online 
help. 

Synchronization 

1. You must install ActiveSync in your PC from the Companion CD. 

2. Connect your phone and PC via a cable as the below picture. 
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3. When the Sync setup automatically, the window pops up. Click 
“Next” button. If it is your first time to use the ActiveSync, you 
should enter the name of the mobile phone, which you name as you 
like.  

4. Follow the wizards on the window to finish the setting.  

5. Click “Finish” button. 
When the connection is set up successfully, the ActiveSync icon in the PC 
toolbar will blink in green. When disconnected, the icon will change into 
gray.   

ActiveSync via Bluetooth 

You can sync the information after the phone had been connected with PC 
via Bluetooth. The detailed please refer to the ActiveSync help. 
 
Notes: You can not sync the movies or videos via Bluetooth.  

Managing the files in PC  

When the connection with your PC is setup, you can use ActiveSync to 
explore all information in your phone. And you can copy and transfer the 
files between your phone and PC. 

1. Click the File menu in the ActiveSync on your PC. And select 
Browser to open the Mobile Device window. 

2. All the information in your phone will be listed in the window. Click 
the Up button to explore the files in your PC. Drag and drop the file 
icon to copy the file. Or use Copy and Paste in the Edit menu to copy 
the file. 

Tips: when you double click the file icon, it is the properties of the file that display. 
You cannot open or run the applications in your phone from PC side.  

Bluetooth  

The phone is with Bluetooth built-in. You can exchange data with other 
Bluetooth devices, without directly wired. The Bluetooth can be set either 
in the status of Turn-on or Turn-off. You can check the Bluetooth status in 
the Today window.  
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Turning on the Bluetooth 

1. Click Bluetooth in the Today.  

2. Tap the Bluetooth icon to turn on. 

 

3. Click “Done”. 

Tips：：：： In order to save battery power, you can turn off the Bluetooth function 
when you are sure not to use it. 

Pairing to your Bluetooth device 

Pairing creates a unique and encrypted wireless link between two 
Bluetooth-enabled devices such as your Bluetooth phone.  
Please make sure the Bluetooth devices in working range, and make the 
device discoverable. 

1. Click “ >Settings>Connections>Bluetooth”.  

2. Click “Devices” and select “New”. Your phone searches all devices 
within range and lists them.  

3. Select the device you want to pair with, and enter a password when 
requested.  

4. Click “Finish”.  

Sending files or data via Bluetooth 

Make sure the Bluetooth devices are in the working range and the Bluetooth 
function is turned on. 

1. Select the files or the application data (for instance Contacts) you 
want to beam in the Explorer. 

2. Click and hold the files or data, and select “Beam File…” option.  
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Bluetooth earphone 

Before using the Bluetooth earphone, ensure that it is fully charged and 
bond as introduced above. Then you can see that Bluetooth is turned on in 
the Today window. And you can receive or make phone calls via the 
Bluetooth earphone. You are recommended to use the dedicated Bluetooth 
earphone.  
  
Answering the coming calls 
When there are coming calls, there are sound notifications both from your 
phone and the Bluetooth earphone. Press Answer key of the earphone, you 
can talk via the Bluetooth earphone. If you press the Answer key of your 
phone, you can use your phone to talk, and press the function key on your 
Bluetooth earphone to switch the call to the earphone from the phone.  
 
Tips:In the phone window, select “Menu” - “Turn Hands-free on” option.  You 
can to switch sound between the Bluetooth earphone and phone. 
 
Making a call 
When you dial from your phone, there is sound notification from your 
Bluetooth earphone, which tells you that your earphone can work. Press the 
function key on your Bluetooth earphone and the sound of talking will be 
switched to the Bluetooth earphone.  
Tips: If you use a wired earphone, you cannot use the Bluetooth earphone together.  

Using the Bluetooth serial port device 

Before using, make sure to set up the bond. 

1. In the window of Bluetooth COM Ports, click “New”. 

2. Create a new virtual serial port for the Bluetooth device. 
 
For details on the Bluetooth device, please refer to the user manual.  
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5   Applications 

Camera 

Taking pictures  
1. Press Camera button to activate the “Camera” application.  

2. Focus on the desired mode.  

4. 
Press down the Camera to finish capturing.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
Tips: As the flash is glaring and might hurt your eyes, please keep a distance from 
persons. If you take a picture for a baby , it is recommended that you turn off the 
flash. 

Self-timer  
1. Press the Self-timer icon. 

2. Press the Camera button. A timer icon is shown before the picture is 
taken.  

 Setting Self-timer 

1. In the camera window, press “”to open the option window. 

2. Click “Self-timer”，and choose the delay period. 
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3. Click “×” to save. 

Flashlight 
� Press “ ” to turn on the Flashlight. 

� Press “ ” again to turn off the Flashlight. 

 
Warning: As the flash is glaring and might hurt your eyes, please keep a distance 
from persons. If you take a picture for a baby , it is recommended that you turn off 
the flash. 

Setting the Resolution 
1. In the camera window, click“ ”to open the option window. 

2. Click “Resolution” to choose your settings.  

3. Click “OK” to save. 

Setting the saving folder 
1. In the camera window, click“ ”to open the option window.  

2. Click “Folder” and change the directory.    

3. Click “×” to save.   

Recording a Video Clip 

1. In camera window，click “ ” to switch the camera to the video. 

2. Press the Camera button to start recording. A red indicator will be 
shown in the window. 

3. Scroll up or down the scroll key to digital zoom. Scroll up or down 
the scroll key to zoom in or zoom out. 

4. Press the Camera button again to stop recording. The video clip can 
be saved automatically. 
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The videos support two kinds of resolutions, 176×144；160×120.  

Tips:  Before recording, please exit all other applications.  

Browsing pictures and videos 

1. Click “    Programs”, then click the “Pictures and Videos” icon. 

2. In the window, it shows all the pictures and videos. Select the file to 
view. 

3. Click “Menu”to set the picture to the desktop or show in the sliding.  
Tips: The pictures and videos you captured have been saved in “My 
Documnents/My pictures” directory.  

Calendar 

With Calendar, you can arrange your appointments in an easy way. You can 
select to view the calendar in different patterns (schedule, day, week, month 
and year) and switch among different patterns by clicking different view 
pattern icons.  

Timer 

Preview window Information

Exit 

Option 
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Creating a new appointment  

1. Click “Menu” -“New Appointment” at the down left corner. 

2. Input the appointment information in the editing screen. 

3. You can set reminding for the appointment. The device will remind 
you before the appointment according to your settings.  

4. Select a category for the appointment. 

5. Click the “OK” button at the upper right corner to save the inputs.  
Notes: If you have set a reminding for the appointment, the device will remind you 
according to your settings even when the device is on the power off status.  

Tasks 

With Tasks, you can learn the working progress and manage the tasks. In 
the tasks list, all those tasks that are not finished on time will show in red. 

Creating a new task 

1. Click “New Task” in Menu to open a new task screen. 

2. Input the task information. Click the “�” next to the subject for a 
pop-up list of the default tasks patterns. You can select the subject 
from the list or input by yourself.  

3. Set the priority for the task. 

4. Set the start time and end time for the task. A time setting window 
will pop up, in which you can change the year and month by clicking 
“�”, “�”, or manually change by clicking the year and month. 

5. Click “No Categories” next to “Categories” to open a window, in 
which you can click on the default frame, or create a new category by 
yourself.  
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6. Click “OK” button at the upper right corner to save the inputs.  

Notes 

Notes acts as pocket electronic memorandums, in which you can type 
letters, writing, draw or make recordings.  

 

Creating a new note 

1. Click “New” at the down left corner to create a new note. You can 
input text, paint or make recordings.  

Word Mobile 

You can use Word Mobile in the same way as you use Word in PC. You can create 
or modify the word documents.  

Creating a new document 
1. Tap“     Programs”，choose“Word Mobile”。 

2. Click “New” to create a new document. Or choose the file to open. 
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Excel Mobile 

With Excel Mobile, you can create worksheets in an easy way, and synchronize or 
copy them between the phone and PC.  

Creating a new worksheet  
1. Tap“     Programs”，choose “Excel Mobile”。 
2. Click “New” to create a new worksheet. Or choose the file to open a 

worksheet. 

 

PowerPoint Mobile 

PowerPoint Mobile can slide the PPT file. You can copy the files via sync or copy 
to the Mini SD card.  

 

Microsoft® Windows Media™ Player 

Microsoft® Windows Media™ Player can play the audio and video files 
that are stored in your device or on a network. You can play files with 
extension names of .asf, .wma, and .mp3. 
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Playing items in your phone. 

Use the Library to find and play songs, videos, and playlists that are stored 
in your Pocket PC or removable storage card. 

If you are not on the Library screen, click MENU>Library. 

1. On the Library screen, click Menu >Update Library. The mobile 
will automatically search the files. Press and hold the file, and you 
can choose to Queue Up. 

2. Or click Menu> Open files. Click a category (for example, my 
music or my play lists), click and hold the item that you want to play 
(such as a song, album, or artist name), and then click Play or Queue 
Up. 

Controller 

Volume 

Speed bar 
 

Menu 
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6    Settings  

Clock Settings 

1. In Today window, click the Date item.  

   
2. Modify the clock and date: select the items and click the arrow to 

adjust the correct contents.  

   
 

Tips: Tap “Others” in the settings window, you can choose “Display the Clock on 
all windows”. Tap “More” in the settings window, you can choose “Display the 
Clock on the title bar in all programs”. 

3. Click OK to save the new clock and date. 
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Alarms Settings 

1. In Today window, click the Date item. 

2. Click Alarms to switch to the alarms setting window. And select the 
time that the alarm works.  

  

USB settings 

The device has two USB setting modes: RNDIS mode and Mass Storage 
Mode. 
RNDIS mode: USB is used as an RNDIS port, you can AcitveSync or 
connect with PC or other devices.  

Mass Storage mode：：：：This mode works only when you have inserted a SD 
card. PC will identify the SD card as a Mass storage device. 

1. In Today window, click  ---Settings. 

2. In the System panel, click USB Setting icon.  

3. In the window, please check the mode you needed. In the USB 
Setting window, please select the appropriate mode according to your 
demand. 

 

Alarm tips 
Set the ring tone of alarm 
 
Set the alarm time 

 Set the period of alarm 

 

Enable alarm 
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4. Click “OK” to save. 
Tips: As you set the FlashDisk mode, your phone can not sync with PC. If you have 
selected the Mass storage mode, your phone can not be synchronized with PC. 

Memory Management 

1. In Today window, click  ---Settings. 

2. In the System panel, click the Memory icon. 

3. In the Memory screen, you can see the current memory allocation 
and make modifications manually.  

 

4. In the Running Programs panel, you can select and stop the 
applications in the Running Program List. 

Master Reset 

If you need to clear all the data and the programs you installed, you can 
run“ Restore Factory Defaults”.  

1. In Today window, click  ---Settings. 

2. In the System panel, click “Restore Factory Defaults”.  

3. Following the steps, you can erase all the user data. Following the 
steps, you can restore your phone to factory default. 

Warning ：：：：It will restore to the factory setting, erased all data and applications. 
Please do mention to do. It will restore your phone to factory default, an may erase 
all user data or applications. Please do mention to do. 

Performance Settings 

1. In Today window, click  ---Settings. 
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2. In the System panel, click the Performance Setting icon. 

3. In the Performance Setting screen, you can select the working mode 
of the phone between the options, Normal Mode, and High 
Performance Mode. The speed of the CPU is different in different 
mode, and leads to different power consume. 

 
 

4. Click OK to save the new settings. 

Button Settings 

You can set the button as the shortcut to the specific program, based on 
your personal preference. 

1. In Today window, click  ---Settings. 

2. In the Personal panel, click the Buttons icon. 

3. In the Buttons screen, select the button you want to change in the 
“1.Select a button:”, and select the program assigned to the button in 
the “2. Assign a program:” 

 

 
 

4. Click OK to save the new setting. 
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Sounds & Notifications Settings 

1. In Today window, click “  ---Settings”. 

2. In the Personal panel, click the Sounds & Notifications icon. 

3. In the Sounds & Notifications screen, select the sounds for screen 
taps, or sounds the events and programs. 

 

4. Click OK to save the new settings. 

Software Installation 

You can install software, which you get from software vendors or 
downloaded from the Internet, into your phone. Please make sure the 
platform needed for the software, including the hardware platform and the 
software platform, before install the software into your phone. 

Installing via ActiveSync 

1. Copy the software to your PC, or put the software CD in your PC 
driver. 

2. Setup the connection between your PC and phone. 

3. Double click the installation program of the software. And all the 
related files copy to your phone automatically.  

Tips: for the software that does not have installation program, you can simply copy 

the execution file（（（（*.exe or *.cab））））to the folder in your phone. Click the software to 
finish the installation. Such software can not be removed by Settings-Remove 
Programs. In the screen of  “no transform program is selected”, click “OK” 
button. 
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Removing programs 

You can remove those programs you don’t use, to release more memory 
space. Be sure that you can only remove those programs you install into the 
phone. Close it first before you remove the program.  
 
Automatically removing 

1. Click  ---Settings, and select the System panel and Remove 
Programs icon.  

2. In the storage memory list-box, select the program item and click the 
Remove button to remove it.  

 
Manually removing 
In the program you want to remove is not listed in the storage memory 
list-box, you have to remove it manually. 

1. Start Explore and find the program file.  

2. Click and press the name of the file, and select “Remove” from the 
popup menu. 

Tips: Manual removal might not remove all the files and settings related with the 
software.  

Setting Theme 

1. Click  --Settings-Personal, and select the Today icon. 

2. In the screen of Today, you can select a theme for your phone, or 
click the Browser button to search for the picture file you want to use 
as the background.  

  

If you want to create a theme by yourself, you can download the theme 
creation software provided by Microsoft. And you can create the theme by 
yourself or download the theme file from the Internet.  
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GPRS and MMS Settings 

GPRS connection settings 

1. Tap “  >settings>connections> connections”. 
2. Tap “Advanced” and “Select Networks”. 
3. In the Network Management windows, tap New below the “Connect to 

the Internet” information. 

4. In General window, enter the name，such as “Internet settings”; 
5. In MODEM window, Tap New and follow the new connection wizard.  
6. Name the connection, such as “My GPRS”. And you can select 

“Cellular Line” or “Cellular Line (GPRS) from the list box “Select a 
modem:”. 

7. In the Access Point Name, input the name and click “Next”; 
8. Enter the “User name”,” Password” and “Domain”; if necessary, click 

“Advanced” to set up the other information. 
9. Tap “Finish” button. 

MMS Settings  

Step 1：：：：Setup MMS connection in the connections window 

1. Tap “ >settings>connections> connections”. 

2. Tap Advanced Tab. Click “Select Networks” button。 

3. In the Network Management windows, tap New below the “Connect 
to the Internet” information. 

4. In General window, enter the name，such as “MMS”; 

5. In MODEM window, Tap New and follow the new connection 
wizard. Please input the name, select the modem (such as the Cellular 
line (GPRS)), enter the Access point name, and so on. Tap Finish to 
save it. 

6. In the “Proxy Settings” window，after checking the two options，Tap 
Advanced button and input the server inform which you can refer to 

the operator. Click OK to save。 
 

Step 2：：：： Setup the SERVER in MMS software 
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1. Start up MMS. 

2. Tap Menu/MMS Configuration…； 

3. In the Servers window, Tap Sample Server and type the information, 
which you can refer to the operator. And select the connect name 
which is established in step 1 from the “Connect Via”.  Tap OK to 
save.  

5. Tap OK to quit. 
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Troubleshooting  
Low battery 
When the battery is low, you can see the battery icon displayed in the 
navigation-bar. And a popup screen displays will remind you to charge your 
battery at your earliest convenience.  
There is a Li-Poly battery built in your phone. When the Li-Poly battery is 
low, your phone turns off automatically. 
 
Why the charging light is not on when charging? 
When the battery is very low, the charging light does not turn on until there 
is enough power in the battery to power the light. So charge the battery for 
a period of time before you can see the charging light blinks and turn on 
your phone. 
 
Why the charging light is always on when charging for a longtime?  
When your phone is not in Flight mode and the SIM card is not inserted, the 
power will be consumed at the same time of charging. The light cannot be 
turned off.  
 

As charging，，，，why the charging light is always twinkle?  
For the battery is in the charging protection status. Please reinsert the 
battery until the light is normal.  
 
The screen does not respond or respond very slowly. 
Click the RESET button to reboot your device. 
 
Nothing displayed.  
Please check the status of the HOLD key.  If in the status of Lock, you 
should unlock it before the LCD works. If nothing displayed on the screen 
while the HOLD key unlocked, you should press the power key for a 
second. If nothing happens yet, please charge your phone. And then soft 
reset your phone.  
 
Stylus is abnormal. 
Redo the stylus adjustment.  
 
Cannot connect to the Internet 
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First, ensure that the settings for the Internet are correctly. For details, 
please refer to the section for “GPRS connection settings” in the User’s 
Guide. 
Check the wireless connection between your phone and the mobile service 
provider, whether connected, any obstruct, etc. 
Tips: Make sure you have got the service from your operator. You cannot set up 
the GRPS connection when you are in the process of synchronizing your phone 
with your PC. 

 
Why the phone automatically set up the GPRS connection again after 

disconnection？？？？ 
Please check whether the application IE is accessing a URL, or the MMS 
application is in the process of sending/receiving an MMS. In either of the 
two situations, the phone connects GPRS automatically. If you don’t need 
the connection, close the application or applications. Then the GPRS will 
be disconnected. 
 
Don’t remember the turn-on password. 
You have to contact the customer service center. 
 
When taking pictures, why can’t I use the digital zoom in/out function? 
Please make sure that the picture size is not in the largest resolution. The 
phone does not support zoom in/out function in the largest resolution mode. 
 
During an incoming call, why is the indicator light not synchronic with 
the ring tone? 
Please check whether the ring tone file is saved in the Mini SD card. If so, 
please copy it into the directory of “My Documents” and reset.  
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Specification 

Processor：：：：Intel PXA270 312MHz 

Memory：128MB FlashROM＋64MB SDRAM 

Operating System: Microsoft Windows Mobile 5.0 

LCD:    2.8”  240 x 320 resolution, 260k colors TFT 

Network：：：： GSM/GPRS 900/1800/1900 

Camera:   2.0M Pixels 

Connectivity:  USB, Bluetooth,  Mini SD Card 

Battery:   Li-Poly 1100mAh 

Size：：：：111 mm x 60 mm x 21 mm 

Weight：：：：147grams with battery 

Battery life estimates: 

Talking time：4 ~ 6 hours* 

Standby time：120~200 hours*  

 

* Subject to local and network conditions 

* Subject to the signal and environment status of the local network. 
Many functions stated in this instruction are the special services offered by the network service 
operators, thus the availability of such services is subject to the network service operator serving 
you. 
Only use the phone accessories recognized by our company. Your phone may be damaged due to the 
use of unauthorized accessories and we shall not be liable for any consequence wherefrom. 
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